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SyncMaster 220TN



 
Notation

 
 
 

 

 

Failure to follow directions noted by this symbol could result in bodily harm or damage to the 
equipment.

 
 

 

Prohibited Important to read and understand at all times

Do not disassemble Disconnect the plug from the outlet 

Do not touch Ground to prevent an electric shock

 
 

 
Power

When not used for extended period of time, set your computer to DPM.  
If using a screen saver, set it to active screen mode.

 
The images here are for reference only, and are not applicable in all cases (or countries).

 
 

Do not use a damaged or loose plug.  
 



This may cause electric shock or fire. 

 
 

Do not pull the plug out by the wire nor touch the plug with wet hands.  
 

This may cause electric shock or fire.

 
 

Use only a properly grounded plug and receptacle.  
 

An improper ground may cause electric shock or equipment damage. ( Class l 
Equipment only.)

 
 

Insert the power plug firmly so that it does not come loose.  
 

A bad connection may cause fire. 

 
 

Do not excessively bend the plug and wire nor place heavy objects upon them, which 
could cause damage.  
 

This may cause electric shock or fire. 

 
 

Do not connect too many extension cords or plugs to one outlet.  
 

This may cause fire.

 
 

Do not disconnect the power cord while using the monitor.  
 

A surge may be caused by the separation and may damage the monitor. 

 
 

Do not use the power cord when the connector or plug is dusty.  
 

If the connector or plug of the power cord is dusty, clean it with a dry cloth. 
Using the power cord with a dusty plug or connector may cause electric shock or 
fire.

 
 



To disconnect the apparatus from the mains, the plug must be pulled out from the 
mains socket, therefore the mains plug shall be readily operable. 
 

This may cause electric shock or fire.

 
 

 
Installation

 Be sure to contact an authorized Service Center when installing your set in a location 
with heavy dust, high or low temperatures, high humidity, and exposed to chemical 
substances and where it will be operated for 24 hours such as at airports, train 
stations etc.  
 
Failure to do so may cause serious damage to your monitor.

 
 

Place your monitor in a location with low humidity and a minimum of dust.  
 

Failure to do so may cause electric shock or fire inside the monitor. 

 
 

Do not drop the monitor when moving it.  
 

This may cause damage to the product or the person carrying it.

 
 

Install the monitor base in a showcase or shelf so that the end of the base does not 
protrude from the showcase or shelf.  
 

Dropping the product may cause damage to the product or the person carrying it.

 
 

Do not place the product on an unstable or small surface area.  
 

Place the product on an even and stable surface, as the product may fall and 
cause harm to someone walking by, specifically children.

 
 

Do not place the product on the floor.  
 

Take care, as someone, specifically children may trip over it. 

 
 

TO PREVENT THE SPREAD OF FIRE, KEEP CANDLES OR OTHER OPEN 
FLAMES AWAY FROM THIS PRODUCT AT ALL TIMES. 
 



Otherwise, this may cause fire. 

 
 

Keep any heating devices away from the power cable.  
 

A melted coating may cause electric shock or fire.

 
 

Do not install the product in places with poor ventilation, for instance, a bookshelf, 
closet, etc.  
 

Any increase in the internal temperature may cause fire.

 
 

Put down the monitor carefully.  
 

Failing to do so may damage the monitor. 

 
 

Do not place the monitor face down.  
 

This may damage the TFT-LCD surface. 

 
 

The installation of the bracket must be done by a qualified professional. 
 

Installing the bracket by unqualified personnel may result in injury.  
Always use the mounting device specified in the owner's manual. 

 
 

When installing the product, make sure to keep it away from the wall (more than 10 
cm/4 inches ) for ventilation purposes.  
 

Poor ventilation may cause an increase in the internal temperature of the product, 
resulting in a shortened component life and degraded performance. 

 
 

Keep the plastic packaging (bag) out of children's reach. 
 

The plastic packaging (bag) may cause suffocation if children play with it. 

 
 



 
Cleaning and Using 

 When cleaning the monitor case or the surface of the TFT-LCD screen, wipe with a 
slightly moistened, soft fabric. 

 
 

Do not spray water or detergent directly onto the monitor.  
 

This may cause damage, electric shock or fire. 

 
 

Use the recommended detergent with a smooth cloth. 

 
 

If the connector between the plug and the pin is dusty or dirty, clean it properly using 
a dry cloth.  
 

A dirty connector may cause electric shock or fire.

 
 

Make sure to unplug the power cord before cleaning the product.  
 

Otherwise, this may cause electric shock or fire. 

 
 

Unplug the power cord from the power outlet and wipe the product using a soft, dry 
cloth.  
 

Do not use any chemicals such as wax, benzene, alcohol, thinners, insecticide, air 
freshener, lubricant or detergent. 

 
 

Others



 
Do not remove the cover (or back). 
 

This may cause electric shock or fire.  
Refer to a qualified servicing company. 

 
 

If your monitor does not operate normally - in particular, if there is any unusual sound 
or smell coming from the monitor- unplug it immediately and contact an authorized 
dealer or the Service Center. 

This may cause electric shock or fire. 

 
 

Keep the product away from places exposed to oil, smoke or moisture; do not install 
inside a vehicle.  
 

This may cause a malfunction, electric shock or fire.  
In particular, avoid operating the monitor near water or outdoors where the 
monitor.

 
 

If the monitor is dropped or the casing is damaged, turn the monitor off and unplug 
the power cord. Then contact the Service Center.  
 

The monitor may malfunction, causing electric shock or fire.

 
 

Disconnect the plug from the outlet during storms or lightning or if it is not used for a 
long period of time.  
 

Failure to do so may cause electric shock or fire. 

 
 

Do not try to move the monitor by pulling only the wire or the signal cable.  
 

This may cause a breakdown, electric shock or fire due to damage to the cable. 

 
 

Do not move the monitor right or left by pulling only the wire or the signal cable.  
 

This may cause a breakdown, electric shock or fire due to damage to the cable.

 
 

Do not cover the vents on the monitor cabinet.  
 

Bad ventilation may cause a breakdown or fire.

 



 
Do not place water containers, chemical products or small metal objects on the 
monitor.  
 

This may cause a malfunction, electric shock or fire.  
If a foreign substance enters the monitor, unplug the power cord and contact the 
Service Center. 

 
 

Keep the product away from combustible chemical sprays or inflammable 
substances.  
 

This may cause an explosion or fire. 

 
 

Never insert anything metallic into the monitor openings.  
 

This may cause electric shock, fire or injury. 

 

Do not insert metal objects such as chopsticks, wire and tools or inflammable objects 
such as paper or matches into the vent, headphone port or AV ports or etc.  
 

This may cause electric shock or fire. If an alien substances or water enters the 
product, turn the product off, unplug the power connector from the wall outlet and 
contact the Service Center. 

 
 

When viewing a fixed screen for an extended period of time, residual image or 
blurriness may appear.  
 

Change the mode to energy saving mode or set a screensaver to a changing 
picture when away.

 

Adjust the resolution and frequency to the levels appropriate for the model.  
 

An inappropriate resolution may cause undesirable picture quality.  
 
22 inch (55 cm) - 1680 X 1050

 
 

Keep the volume at a comfortable level when using the headphones. 
 

Excessively loud volume level may damage hearing.

 

Viewing the monitor continuously at a too close angle may result in damage to your 
eyesight. 

 



To ease eye strain, take at least a five-minute break after every hour of using the 
monitor. 

 
 

Do not install the product on an unstable, uneven surface or a location prone to 
vibrations.  
 

Dropping the product may cause damage to the product or the person carrying it. 
Using the product in a location prone to vibrations may shorten the lifetime of the 
product or may cause the product to catch fire.

 
 

When moving the monitor, turn off and unplug the power cord. Make sure that all 
cables, including the antenna cable and cables connected to other devices, are 
disconnected before moving the monitor.  
 

Failure to disconnect cables may damage it and cause fire or electric shock. 

 

Place the product out of children’s reach, as they could damage by hanging onto it.  
 

A falling product may cause injury to the person or even fatality. 

 
 

When not using the product for an extended period of time, keep the product 
unplugged.  
 

Otherwise, this may cause heat emission from the accumulated dirt or degraded 
insulation, causing electric shock or fire.

 

Do not place your children's favorite toys or any other objects of interest on the 
product.  
 

Children may try to climb on the product to retrieve an object.  
The product could fall, causing injury or even fatality. 

 
 

When lifting up or moving the monitor, do not lift the monitor upside down while 
holding only the stand.  
 

This may cause your monitor to fall, and become damaged or cause personal 
injury.

 

 
 

Good Postures When Using the Monitor

  Try to maintain a good posture when using the monitor.

 
Keep your back straight. 
 
Keep a distance of about 45 ~ 50 cm between your eyes and the 



 
 

 
 

monitor screen. Look at the screen from slightly above it, and have 
the monitor directly in front of you. 
 
Tilt the monitor upwards by 10 ~20 degrees. Adjust the monitor 
height so that the top of the monitor is slightly below eye level. 
 
Adjust the monitor angle so that there is no reflected light on the 
screen.Try to maintain your arms perpendicular to your armpits. 
 
Keep your arms level with the back of your hands. 
 
Keep the angle of the elbow perpendicular. 
 
Keep the angle of the knees at more than 90 degree. Do not let your 
feet fall up from the floor. Adjust the arm position so that it is below 
the heart  

 

Correct Disposal of This Product  
(Waste Electrical & Electronic Equipment) - Europe only

(Applicable in the European Union and other European countries with 
separate collection systems)  
 
This marking shown on the product or its literature, indicates that it should not 
be disposed with other household wastes at the end of its working life. To 
prevent possible harm to the environment or human health from uncontrolled 
waste disposal, please separate this from other types of wastes and recycle it 
responsibly to promote the sustainable reuse of material resources.  
 
Household users should contact either the retailer where they purchased this 
product, or their local government office, for details of where and how they 
can take this item for environmentally safe recycling.  
 
Business users should contact their supplier and check the terms and 
conditions of the purchase contract. This product should not be mixed with 
other commercial wastes for disposal.  
 



PRODUCT INFORMATION (Image Retention Free) 

 
LCD Monitors and TVs may have an image retention when switching from one image to another 
especially after displaying a stationary image for a long time.  
This guide is to demonstrate a correct usage of LCD products in order to protect them from 
Image retention.  

 

Warranty
Warranty does not cover any damage caused by image retention.  
Burn-in is not covered by the warranty. 

What is Image retention ? 
During normal operation of a LCD panel, pixel image retention doesn't occur. However, 
if the same image is displayed for a long time, a slight difference in electric charge 
accumulates between the two electrodes which encase the liquid crystal. This may 
cause the liquid crystal to build up in a certain areas of the display. Thus, the previous 
image is retained when switching to a new video image. All display products, including 
LCD,are subject to image retention. This is not a product defect.  

Please follow the suggestions below to protect your LCD from image retention 

Power Off, Screen Saver, or Power Save Mode 
Ex) 

Turn the power off when using a stationary pattern. 

Use a Screen saver if possible 

Set the Monitor to power off with the PC Display Properties Power Scheme.  
 

- Turn the power off for 4 hours after 20 hours in use 
- Turn the power off for 2 hours after 12 hours in use  

- Screen saver in one color or a moving image is recommended. 

Suggestions for specific applications 
Ex) Airports, Transit Stations, Stock Markets, Banks, and Controlling Systems  
We recommend that you follow set up of your display system program as below: 
 
 
Display Information together with Logo or Moving image cycle. 
Ex) Cycle : Display Information for 1 hour followed by a  
Display Logo or moving image for 1 minute.  
 
Change the Color Information periodically (Use 2 different colors).
Ex) Rotate the Color Information with 2 colors every 30 minutes.  
 

Avoid using a combination of characters and background color with large 
difference in luminance. 
Avoid using Grey colors, which can cause Image retention easily.  
 

Avoid: Colors with big difference in luminance (Black & White, Grey)  
Ex)  

 
 

Recommended settings: Bright colors with little difference in luminance  
- Change the characters color and background color every 30 minutes  
Ex) 

 
 

- Every 30 minutes, change the characters with movement.  



Ex)

The best way to protect your monitor from Image retention is to set your PC or 
System to operate a Screen Saver program when you are not using it.

Image retention may not occur when a LCD panel is operated under normal conditions. 
 
Normal conditions are defined as continuously changing video patterns. When the LCD 
panel is operated for a long time with a fixed pattern (-over 12 hours-), there may be 
slight difference in voltage between electrodes that work the liquid crystal (LC) in a 
pixel. The voltage difference between electrodes increases with time, forcing the liquid 
crystal to lean. When this occurs, the previous image may be seen when the pattern is 
changed.  
To prevent this, the accumulated voltage difference must be decreased. 

 

Our LCD Monitor satisfies ISO13406-2 Pixel fault Class II 



 
 

 

 

 
 
 
 

Features 

What is a network monitor?

 

A network monitor can be used for the same purposes as a common monitor. It also provides the 
functionalities of most computers, such as an Internet connection, creating documents, editing 
images, via a connection to the host PC over the LAN. In addition, it allows you to connect an 
external device (DSC, MP3, external storage media) to the USB port and play music, movies and 
games. It is a new concept monitor.

You also can share the screen being displayed on your network monitor with other users by 
connecting a projector or other display device to its RGB OUT port. You can use this functionality for 
video conferencing and a variety of shared tasks.

In addition, because Windows XP is installed on your network monitor, you can perform Internet 
searches and USB memory searches independently of your host PC.

 

 
Package Contents

Please make sure the following items are included with your monitor.  
If any items are missing, contact your dealer.  



 
 

 

 

 
 

 

 
 

 

 
 

 
 

Contact a local dealer to buy optional items.

Unpacking

 
  Without Stand

Monitor 

 
  With Stand 

Monitor & Simple stand

Manual

Quick Setup Guide Warranty Card 
(Not available in all locations)

User's Guide, Monitor Driver, 
Natural Color, 

MagicTuneTM software 

Cable

Power Cord RGB-IN Cable USB Cable 

Sold separately



 
 

 

 

 

Keyboard (USB) Mouse (USB)  

Others

  

Cleaning Cloth  

This is an accessory that can be added depending on the model.

 

 
 

 

 

 

Your Monitor

Front

 

 

Touch a button lightly with your finger. 

MENU button [ ]  
 

Opens the OSD menu. 
Also use to exit the OSD menu or return to the previous menu. 

Adjust buttons [
] 

These buttons allow you to adjust items in the menu.

MagicBright™ 
button  
[ ] 

MagicBright™ is a new feature providing optimum viewing environment 
depending on the contents of the image you are watching. Currently six 
different modes are available: Custom, Text, Internet, Game, Sport and 
Movie. Each mode has its own pre-configured brightness value. You can 
easily select one of six settings by simply pressing MagicBright™ control 



 

 

 

buttons.  
1) Custom 

Although the values are carefully chosen by our engineers, the pre-
configured values may not be comfortable to your eyes depending on 
your taste. If this is the case, adjust the brightness and contrast by 
using the OSD menu. 

2) Text 
For documentations or works involving heavy text. 

3) Internet 
For working with a mixture of images such as texts and graphics. 

4) Game 
For watching motion pictures such as a game. 

5) Sport 
For watching motion pictures such as a Sport. 

6) Movie 
For watching motion pictures such as a DVD or Video CD. 

>> Click here to see an animation clip 

Volume button [ ]  
 

When OSD is not on the screen, push the button to adjust volume. 
>> Click here to see an animation clip 

Enter button [ ] / 
 
SOURCE button 

Activates a highlighted menu item. /  
Push the ' ', then selects the video signal while the OSD is off.  
(When the ' ' button is pressed to change the input mode, a message 
appears in the upper left of the screen displaying the current mode -- 
Analog or Client input signal.) 
>> Click here to see an animation clip 

AUTO button 
[AUTO]

Use this button for auto adjustment. 
>> Click here to see an animation clip 

Power button [ ] Use this button for turn the monitor on and off. 

 
In these cases your monitor will be forcefully shut down and this may cause 
damage to your operating sysetm. Therefore ensure that the EWF function is 
enabled. 

When unable to boot up your computer because of a Windows crash, please 
contact your Administrator.

Be careful as pressing the Power button in client mode will shut down 
Windows XPe. Be careful that if you force shut down Windows it may 
cause damage.

1. Turn the power off by holding down the Power button after switching to 
Monitor mode from Client mode. 

2. Make sure to shut down Windows by clicking Start > Shut Down... > Shut 
down > OK in Client mode.  
If Windows is corrupted and does not boot up, consult your system 
administrator.

Power indicator This will enable you to see the overall power status of the system. For more 
information, see the PowerSaver section.

Speaker 
 

You can hear sound by connecting the soundcard of your PC to the 
monitor. 

MIC 
 

Transmits voice when you are having a conversation using the Syncon.

Camera 
 

Transmits video when you are having a conversation using the Syncon.

Both the microphone and camera are only available when operating them via the 
Syncon.
See PowerSaver described in the manual for further information regarding power saving 
functions. For energy conservation, turn your monitor OFF when it is not needed, or 
when leaving it unattended for long periods.

Camera

  

This is a dedicated camera for video chatting and video calling. 
Do not rotate the camera using excessive force, as this may cause a product 
malfunction.  



 
 

 

 

 

Rear

 

 

The configuration at the back of the monitor may vary from product to product.

 
 

 POWER   

 
 

 
POWER  
: Connect the power cord for your monitor to the POWER on  
the back of the monitor.  

  

  
 RGB OUT  

 
 

 
Connect when using it as a monitor.  

  
 2 /  

 
 

 
2 

: Connect the 2 of the USB monitor and a USB device with 
the USB cable.

 
: Connect the  of the monitor and the USB of the computer 
with the USB cable.

 

To use 2, you have to connect the  
to the PC.  
Make sure to use the USB cable supplied with this 
monitor to connect the monitor's  and your 
computer's USB.  

  
 LAN (LAN Connection Terminal)

 



 

 

 
 

Connect when using it as a monitor. 

  
 RGB IN 

 
 

 
RGB IN 
:Connect the signal cable to the 15-pin, D-sub port on the back of 
your monitor.  

 

  
 AUDIO IN 

 
 

 
AUDIO IN  
: Connect the audio cable for your monitor to the audio port on the 
back of your computer.  

  
  / MIC/

 
 

 
 (Earphone jack)  

: Headphone connection terminal.
MIC (The Microphone connection terminal) 
: Connect a microphone to the MIC terminal. 

 (USB Connection Terminal) 
: Connect USB devices such as a mouse, keyboard and external 
storage devices (DSC, MP3, external storage, etc.).  

  
 Kensington Lock

 
 

 
The Kensington lock is a device used to physically fix the system 
when using it in a public place.  
(The locking device has to be purchased separately.)  
For using a locking device, contact where you purchase it. 

  

See Connecting Cables for further information regarding cable connections.



 

 

 

 

Connecting Cables

Connect to the host PC using a LAN cable 

 

 
 Host PC Hub LAN Cable Monitor

 

 

Connect the power cord to the power terminal at the back of the monitor. 
Connect the mouse and the keyboard to the USB ports. 
Connect the LAN port on the back of the monitor and the hub. 
Connect the hub and the LAN port of the host PC. 

The host PC must have an IP address.  
 
After connecting the LAN and setting the IP address, you can view the host PC screen on the 
monitor.  
 
Use the RGB IN port to directly connect the monitor to a PC.  
 
Connect to the RGB OUT port to display the same picture on another monitor such as the 
projector. (For presentation purposes)  
 
Use the USB port to connect an external storage device (DSC, MP3, external storage, etc.). 

Connecting Cables (When used as a normal monitor)



 

 
 

 

 

Connect the power cord for your monitor to the POWER port on the back of the monitor.  
Plug the power cord for the monitor into a nearby outlet.

Use a connection appropriate for your computer. 

  Using the D-sub (Analog) connector on the video card.  
- Connect the D-Sub Cable to the RGB IN port on the back of your monitor.  

 [RGB IN]

 Using Macintosh  
- Connect the monitor and the Macintosh computer using the computer connection cable.

If the monitor and the computer are connected, you can turn them on and use them.

External Device Connection

D-sub 15-pin port  
[RGB OUT] 

Use it by connecting it to another monitor.  
(The picture of the main monitor is displayed on the connected 
monitor.)

2 
(USB Connection Terminal) 

Connect USB devices such as a mouse, keyboard and external 
storage devices (DSC, MP3, external storage, etc.).  
(Connect the 2 of the USB monitor and a USB device with the 
USB cable.)

 Connect the of the monitor and the USB of the computer with the 
USB cable.



 

LAN  
(LAN Connection Terminal)

Connect the LAN cable. 

 
 

Connecting USB 

 

 
 

 
Connecting USB 
 Turn on your monitor and PC. If you connect the  cable to the  connector of your monitor and the 

2 cable to the 2 connector of your PC, the installation programs related to microphone and 
camcorder are performed automatically. 

You can use a USB device such as a mouse, keyboard, Memory Stick, or external hard disk drive by 
connecting them to the 2 port of the monitor without connecting them to the PC. 

The USB port of the monitor supports High-Speed Certified USB 2.0.  

 High speed Full speed Low speed 

Data Rate 480 Mbps 12 Mbps 1.5 Mbps

 

 Connect the  port of the monitor and the USB port of the computer with the USB cable.  
 

 

 
 

 Connect the  port of the USB monitor and a USB device with the USB cable.  
 
 

 The use procedures are as the same as those for using an external device connecting to the PC. 

 To use  port, you have to connect the  to the PC.  

Make sure to use the USB cable supplied with this monitor to connect the monitor's  
port and your computer's USB port.  
 



 
 

 
 

You can connect and use a keyboard and mouse.  
You can play a file from a media device. 
(Examples of media devices: MP3, digital camera, etc.)  
You can run, move, copy or delete the files on the storage device. 
(Examples of storage devices: external memory, memory card, memory reader, HDD-type MP3 
player, etc.)  
You can use other USB devices that can be connected to a computer. 

 
Do not disconnect the USB cable while the installation is in progress. 
The program may not be installed completely or may not work normally.  
When connecting a device to the 2 port of the monitor, connect the device using a 
cable appropriate to the device.  
(For the purchase of the cable and external devices, ask the service center of the 
corresponding product.)  
The company is not liable for problems or damages to an external device caused by 
using an unauthorized cable for the connection.  
Some products do not follow the USB standard, and it may cause a malfunction of the 
device.  
If the device malfunctions even if it is connected to the computer, contact the service 
center of the device/computer.  

 

 

 
 
 

Using the Stand

This monitor supports various types of VESA-standard bases. You need to either fold or 
remove the base in use to install a VESA base. 

 
 

 

 

Tilt angle 

The monitor may be reclined -3 to 22 degrees

 
 
 

 
Attaching a Base

This monitor accepts a 100 mm x 100 mm VESA-compliant mounting interface pad.



 

 
 

Monitor 
  

Mounting interface pad (Sold separately) 

1. Turn off your monitor and unplug its power cord.

2. Lay the LCD monitor face-down on a flat surface with a cushion beneath it to protect the 
screen.

3. Remove four screws and then remove the stand from the LCD monitor.

4. Align the mounting interface Pad with the holes in the rear cover mounting pad and 
secure it with four screws that came with the arm-type base, wall mount hanger or other 
base.

  

 
Do not use screws longer than the standard dimension, as they may damage the inside of 
the Monitor.  
For wall mounts that do not comply with VESA standard screw specifications, the length of 
the screws may differ depending on their specifications. 
Do not use screws that do not comply with the VESA standard screw specifications. 
Do not fasten the screws too tightly, as this may damage the product or cause the product 
to fall, leading to personal injury. 
Samsung is not liable for these kinds of accidents. 
Samsung is not liable for product damage or personal injury when a non-VESA or non-
specified wall mount is used or the consumer fails to follow the product installation 
instructions.  

  

 
To mount the monitor on a wall, you should purchase the wall mounting kit that allows you 
to mount the monitor at least 10cm away from the wall surface.  
Contact the nearest Samsung Service Center for more information. Samsung Electronics 
will not be responsible for damages caused by using a base other than those specified.  
Please use Wall Mount according to the International standards. 



 
What is XPe Client?

 

An Microsoft Windows XP Embedded(XPe) client uses the Microsoft Windows XP Embedded operating
system. When an XPe client is connected to a Citrix ICA server or another server that can provide the 
Microsoft RDP service, data for the keyboard, mouse, audio/video and display are transmitted through 
the network between the client and the server.  
 

 

Connectable Servers  
 
A Citrix ICA (Independent Computing Architecture) Server 
- A Microsoft Windows 2000/2003 Server where the terminal services and Citrix MetaFrame are 

installed
- A Microsoft Windows NT 4.0 Server where the Citrix MetaFrame is installed  

 
A Microsoft RDP (Remote Desktop Protocol) Server  
- A Microsoft Windows 2000 Server where the terminal services are installed
- A Microsoft Windows 2003 Sever
- A Microsoft Windows XP Professional

This manual describes the functions provided by the XPe Client. However, it does not explain 
general functionalities of Windows XP Embedded. For more general information on Windows XP 
Embedded , refer to Windows XP Embedded Help provided by Microsoft. 

 

 

 
 

 

Logon

Logon

 
When the client starts, you can logon to the server by entering your username and password. The 
default usernames already configured are ‘Administrator’ and ‘User’, and their passwords are a space.  
 

Auto Log On

The client can log onto the server using a predefined account without the user information having to be 
manually entered every time.  

Only an administrator (that is, only when you logged on as an administrator) can specify the username, 
password, and domain for an account for which ‘auto log on’ is activated. At this time, the password 
cannot be left empty.  
 
 



 

  

 

 

 

 

 

 

 

Windows XP Embedded Desktop

User

 

When a user logs in, the User Desktop appears, as shown in the figure below. The default icons that 
appear on the User Desktop are Citrix Program Neighborhood, Remote Desktop Connection and 
Internet Explorer. You can also run this connection from the Start menu. The audio volume icon, VNC 
server icon and system time are displayed on the User Taskbar.  
When logged on as a user, there are many restrictions that protect the system from incorrent user 
actions. You cannot access the system drives and there are restrictions on configuring properties for 
them. To configure the client’s advanced and detailed settings, log on as an administrator.

Administrator

 

If you logon as Administrator, the Administrator Desktop appears, as shown in the figure below. The 
default icons that appear on the Administrator Desktop are My Computer, My Network Places, Citrix 
Program Neighborhood, Remote Desktop Connection, Internet Explorer, and Recycle Bin. You can 
also run the Citrix Program Neighborhood, Remote Desktop Connection, and Internet Explorer from the 
Start menu. The audio volume icon, VNC server icon, Enhanced Write Filter status icon, and system 
time are displayed on the Administrator Taskbar. The Administrator privilege is required for adding and 
removing programs.  
 

Log off, Restart, Shut down

 

- To log off the current session, shut down or restart your client, use the Start menu. Click Start → 
Shut down. The Shut Down Windows dialog box is displayed. Select an operation from the combo 
box and click OK. You can also log off or shut down your client using the Windows Security dialog 
box displayed when pressing the Ctrl + Alt + Del keys. If ‘Force Auto Log on’ is activated, you will be 
immediately logged on after each log off.
 

- The Client Log off, Restart and Shutdown take effect on the operations of the EWF(Enhanced Write 
Filter). To keep the changed system configuration, you must save a cache for the current system 
session into flash memory. Failing to do so will cause the changed configuration to be lost when the 
client is shutdown or restarted. (In the case of logging off, the configuration is remembered when 
loggin in again.) For more information on the Enhanced Write Filter, refer to the Program Help .



 

 

 

 

 

Programs

 

- XPe Client is a client/server-based computing platform. On this platform, the client accesses the 
server each time it needs a program and it only receives the user interface screens from the server. 
Hence, various programs, such as ICA, RDP, and VNC, which are installed on a XPe Client, are 
used to help the client access the server and perform user tasks.

Citrix Program Neighborhood

Independent Computing Architecture (ICA) allows you to use applications on the server through a wide 
range of platforms and networks regardless of their basis.  
The ICA MetaFrame Server separates the application’s internal logic from the user interface. Due to this 
separation, users only work with the user interface on the client. The actual application is 100% run on the 
server. In addition, running an application through ICA only uses approximately 10% bandwidth compared 
to running it locally. By using this feature of ICA, users can do more work on the client than working locally. 
The core technologies of ICA are as follows:
 

  
Thin Resource

 
- Low system requirements needed for running ICA; a computer equipped with an Intel 286 
processor and 640K RAM is sufficient. This means ICA can be run on any computer that exists at 
present.
Thin Wire

 
- The default bandwidth required by ICA protocol is 20 kbps, on average. Therefore, even with a 
Dial-Up or ISDN connection, a consistent performance is maintained. Any program, however large 
it is, can be run stably at a low bandwidth.
Universal Application Client

 
- The Citrix ICA protocol separates the user interface from the application. While an application is 
running on the WinFrame multi-user application server, its user interface is running on the thin 
client software of WinFrame. Hence, in any environment, it is possible to run applications fast. 
Platform Independent

 
- ICA is inherently being operated regardless of the operating system platform. Because the clients 
for UNIX, OS/2, Macintosh, and Non-DOS are already on the market, you can run Windows 
applications on these operating systems.

  
The Citrix Program Neighborhood is a program that manages these ICA connections. To start the Citrix 
Program Neighborhood, select Start → Programs → Citrix → MetaFrame Access Clients → Program 
Neighborhood, or double-click the Citrix Program Neighborhood icon.  

 To create a new ICA connection, double-click the Add ICA Connection icon and follow these steps:  
 

 

 

 
 

1. Select the type of connection to create.  
 



 
 
 

2. Type the connection name and the server name (IP address or DNS name).  
 

 
 

3. Configure the degree of compression for the data to be sent and received, and the degree of 
reliability for sessions.  
 

 
 

4. To login to the server automatically, enter your username, password and domain. If you do not enter 
them now, you will be prompted to enter them whenever you connect to the server.  
 



 
 

5. You can specify the color and size of the window to be displayed.  
 

 
 

6. If a connection succeeds, the server’s desktop appears on the client. In this step, you can make an 
application run automatically.  
 

 
 

7. Click Finish to complete creating the new connection.  
 



 

 

 

 
 
 

 
For more information on the ICA Client Program, visit the Citrix web site.

The Remote Desktop Connection

 

You can control a running terminal server or another computer (Windows 95 or later) remotely through 
a remote desktop connection.

 

Remote Desktop  
 
- Windows XP Professional or Windows 2000/2003 Server must be installed on the computer to 

be controlled remotely. This computer is called a host.
- A remote computer running on an operating system later than Windows 95 is required. This 

remote computer is called a client. The client software for the remote desktop connection must 
be installed on the client.

- You must also be connected to the Internet. A broadband Internet connection is good for high 
performance. However, because the remote desktop transmits a minimum set of data including 
the display data and keyboard data to control the host remotely, a broadband Internet 
connection is not required. You can run a remote desktop on a low bandwidth Internet 
connection.

When running a remote desktop on Windows XP Professional, you cannot use the operating 
system of your computer.

 

 
Enabling Your Computer as the Host  
 
You must enable the Remote Desktop feature to control it from another computer. You must be 
logged on as an administrator or a member of the Administrators group to enable Remote Desktop 
on your computer. Follow these steps:  
 
- Open the System folder in the Control Panel. Click Start, point to Settings, click Control Panel, 

and then double-click the System icon.
- On the Remote tab, select the “Allow users to connect remotely to this computer” checkbox.
- Ensure that you have the proper permissions to connect to your computer remotely, and click 

OK.
- Leave your computer running and connected to the client’s network with Internet access.
  
 



 

 

 

 

 

 

Start a Remote Desktop Session on the Client  
 
Once you have enabled your host computer to allow remote connections and installed the client 
software on a Windows-based client computer, you are ready to start a Remote Desktop session.  
You must first establish a virtual private network connection or remote access service connection 
from your client computer to your host computer.  
 

1. Click Start, point to Programs, and then click Remote Desktop Connection. Or double-click the 
Remote Desktop Connection icon.  

The Remote Desktop Connection window will open. 

 
2. Enter the host computer name. You can configure detailed settings by clicking the Options button.  

 

 

3. Options  
 
- General: Enter the login information to connect to the host computer. Enter your username and 
password to login to the host automatically.  
 



 
 
- Display: The Remote Desktop Connection sends and receives compressed screen data. If you set 
the resolution and color quality to the high option, the speed may become slow.  

 
 
- Local Resource: Specify whether to use the hard disks and ports.  



 
 
- Programs: Specify whether to display the Desktop or run an application whenever you are 
connected. The default is ‘Desktop’.  
 
 

 
 
- Experience: You can select your connection speed, and select and share environmental options.  
 



 

 

 

4. Click Connect. The Log On to Windows dialog box appears.  
 

5. In the “Log On to Windows” dialog box, type your username, password, and domain (if required), and 
then click OK. The Remote Desktop window will open and you will see the desktop settings, files, and 
programs that are on the host computer.  
 

 For more information on Remote Desktop Connections, visit the Microsoft web site.  

RealVNC Server 

 

RealVNC (Virtual Network Computing) is a software program that allows you to connect to another 
computer on a network and control it remotely. Compared to the Windows terminal service which has a 
similar function, RealVNC allows only one administrator to connect to the server at a time. That is, if 
another is connected to the server as an administrator, the previous administrator connection will be 
disconnected.  
In RealVNC, the server and the viewer communicate via the VNC protocol. You must install a RealVNC 
server on the computer you wish to control remotely, and a VNC viewer on the computer which 
remotely controls the computer where the RealVNC server is installed. Hence, the RealVNC server 
program is installed on a XPe client.  
 
By using this program, you do not have to move directly to the client site to resolve its problems. 
Instead, you can connect to the client from the server and solve problems remotely. For this reason, 
RealVNC is being used very usefully.  
Only administrators can configure the RealVNC server properties. To display the configuration dialog 
box for RealVNC, double-click the RealVNC icon in the system tray. From this dialog box, you can run 
a VNC server and configure a password and various properties. The default password is set to 
‘Administrator’. Note that it is case-sensitive.
  
 



 
 

 

 
 

 

Internet Explorer 

 
A XPe Client includes Internet Explorer. This program is permitted for all users. For more information 
on Internet Explorer, visit the Microsoft website.
  

Enhanced Write Filter 

 

Enhanced Write Filter (EWF) protects a flash volume from write access and consequently, preserves 
the durability of the flash device. EWF provides read and write access through a cache to the client 
instead of allowing direct access to a flash volume.  
 
If EWF is activated, data is not stored to the flash. The data stored in the cache is only effective while 
the client is operating. The cached data will be lost when restarting or shutting down your client. 
Therefore, to store the data written to the registry, favorites and cookie folders, etc., the content stored 
in the cache should be transferred to the flash.  An error message is displayed when it is not possible 
to write to the cache due to a lack of memory. If this message is displayed, you have to deactivate 
EWF to flush the EWF cache. The user can double-click the EWF icon on the tray at the bottom right of 
the screen to call the EWF Manager. A user can also change the EWF configuration by entering EWF 
management commands at the command prompt. This task requires the administrator privilege.  
 

  
Enable disk write protection and restart your computer  
 
-

If the EWF is disabled, enable it. If this item is selected, the cache is flushed and the EWF is 



 

 

enabled. After restarting your computer, the configurations and file system information for the 
client are written to a cache. You can also perform this operation by entering “ewfmgr.exe c: -
enable” at the command prompt and restarting your computer.

 

Disable disk write protection and restart your computer  
 
- This item is activated when the EWF is running. If this item is selected, the current states of the 

client (saved in a cache) are saved to a flash volume and the EWF is disabled. After restarting 
your computer, the configurations and file system information for the client are written to a flash 
volume. You can also perform this operation by entering “ewfmgr.exe c: -commitanddisable” at 
the command prompt and restarting your computer.

 

Write the changes to a disk  
 
- This item is activated when the EWF is running. If this item is selected, the current states of the 

client (saved in a cache) are saved to a flash volume. However, the state of EWF will not be 
changed. You can also perform this operation by entering “ewfmgr.exe c: -commit” at the 
command prompt.

You can view the configurations for the protected volumes by entering “ewfmgr.exe c:” at the command prompt.
  
 In addition, the EWF icon in the system tray shows the current state of the EWF.
  
 

 

The EWF is enabled.

  
The EWF is disabled.

  
Windows Media Player 

 
The XPe Client includes Windows Media Player 6.4. With Windows Media Player, you can play audio 
and video files on a website.
  

 

 

Control Panel

The Windows Firewall

The Windows Firewall protect your client further. The Windows Firewall allows you to restrict incoming data 
to your client from other computers, thus helping to control your client data more effectively. In addition, it 
also provides a barrier between your client and network connections reducing unauthorized access, viruses, 
and worms across networks.  
You can think of a firewall as a sentinel which identifies incoming data from the Internet and other networks. 
According to the firewall settings, incoming data to your computer is either permitted or rejected.  
The Windows Firewall is, by default, installed and activated on your client. However, your administrator can 
turn it off. You can choose and select a different firewall. Therefore, it is not required for you to use the 
Windows Firewall. Estimate the functions of other firewalls and choose the best one to fit your 
requirements. To install and run a different firewall, you must turn off the Windows Firewall.  
 
You must be logged on as administrator to turn the Windows Firewall on or off. Follow these steps to turn 
the Windows Firewall on or off. 

1. Run the Windows Firewall.  
 

2. Click on one of these options under the General tab. 
On (recommended) : This is the recommended setting for normal use.  
On with no exceptions : This settings blocks all unwanted access to your client, including all 
requests to programs and services selected in the Exceptions tab. Use this setting when you 
need to protect your client to the maximum extent.  
Off (Not recommended) : Turning off the Windows Firewall may make your client and network 
more vulnerable to viruses and intruders.  
 
 

 

 

Configuring Utilities 

Local Drive

C Drive  



 

 

 
 
 

 

 

 

 

 
The C drive is used for the system. If there is less than 3MB of free space available, the client OS 
cannot operate. Therefore, always ensure that there is a sufficient amount of free space available. 
EWF can help maintain available space by preventing the C drive being written to directly. 

 

 

D Drive 
If the size of the flash memory is larger than 1 GB, the D drive (that is, the flash memory) is used 
as temporary file storage. By specifying the folder path on drive D to frequently used system files, 
you can manage the system drive effectively. We recommend using this feature for temporary files 
such as the paging file, temporary internet files, and event logs files. 

 

 

Saving Files  
 
Your client uses a fixed size of flash memory. Therefore, it is better to save files to the server 
rather than to your client.

Mapping a Network Drive

 

The administrator can map a folder to a network drive. To keep the mapping information after restarting 
the client, take note of these directions carefully.  
 
- Select the Reconnect at logon checkbox in the Map Network Drive dialog box.
- If EWF is activated, save the changes to the disk.

Installing MUI (Multi-language User Interface) 

 

The MUI Setup program helps you set up languages on the XPe client. In addition, you can delete an 
original language pack to extend the available free disk space. If you want to change the default 
language, standards or formats, use the Regional Options in the Control Panel.
 
To add a language to your XPe client, follow these steps:
- Log on as an administrator.
- If EWF is activated, you must deactivate it before starting the installation.
- Click Start and click Run . Type muisetup.exe in the Open box and click OK . A list of languages 

that can be installed is displayed as shown below.
- Select the language you want to install and click Install from the File menu. The installation will 

begin. 
 

  
You can delete an original language pack using the Delete menu in the File menu.  
This operation deletes the original language pack only and does not delete the copy installed on your 
XPe Client.  

 
Recover the System

Overview



 

 

 

  

 

The XPe Client provides a recovery function which allows you to revert to a backed up system when 
encountering a serious problem. You can back up an OS image which is working normally to USB 
memory or the PXE server. You can revert to a backed up image when your client has one of these 
problems:  

 When a system file is deleted accidentally or is corrupted 
 When the client computer is unstable or there is a problem with a device driver 
 When problems occur, after installing a new program or device 
 When the client computer is infected with a virus 
 When Windows XP Embedded fails to start 

How to Recover the System

 

 

Recovery Using USB Memory 
By following these steps, you can save all necessary files to USB memory, and boot up with the 
backed up system on the USB memory and recover the system.
- Perform system formatting for your USB memory in order to make it bootable.
- Save the Windows XP Embedded image and the Backup/Recovery Utility which will be 

recovered later to your USB memory.
- Boot up with the USB memory.
- Recover the system using the Windows XP Embedded image and the Backup/Recovery Utility 

in the USB memory.

 

 
 For more information, refer to the PXE Server User Manual. 

Recovery Using Network Booting
This method is provided through the PXE (Preboot eXecution Environment) server. The PXE sever 
provides a client/server interface based on TCP/IP, DHCP, and TFTP. It allows an administrator at 
a remote location to configure and boot the operating system onto a client over a network.  
- Implement a PXE server.
- Save the Windows XP Embedded image and the Backup/Recovery Utility which will be 

recovered later onto the PXE server.
- Boot the client via the network.
- Recover the system using the Windows XP Embedded image and the Backup/Recovery Utility 

saved on the PXE server via the network.



 
What is SYNCON?

  

List of Features 
 
- A thin client (computer) with an integrated LCD monitor which has the embedded VoIP(Voice 

Over Internet Protocol) video call function.
- A webcam (web camera), microphone, and speaker integrated into one device

SYNCON function 
 
- Office document and content sharing during a call
- PIP function
- Address book and call history management
- Instant Messaging

 
 

 

 

Configuring Your Network

Configuring a Static IP

 Before using SYNCON, you have to configure your network IP address settings, in order to use 
SYNCON.

1. Select and right-click My Network Places on the Windows Desktop and then select Properties 
from the displayed menu.   
 

 
 

2. Select and right-click Local Area Connection and then select Properties from the displayed menu. 
 



 
 

 

 

 
 

3. In the Local Area Connection Properties window, select Internet Protocol (TCP/IP) and click on 
Properties. 
 

 
 

4. Select Use the following IP address and Use the following DNS server addresses in the General 
tab in the Internet Protocol (TCP/IP) Properties, enter an IP address and click the OK button as 
shown below.  
 

 
 

To use a fixed IP address, consult your network administrator.

Checking your Pc’s IP Address

 
Check the IP address of your PC. If you do not know the IP address of your PC, you cannot use 
SYNCON’s video call function. 
 



1. Click Start and Run. 
 

 
 
 

2. In the Run window, type 'cmd' and click OK. 
 

 
 

3. If the following screen appears, type 'ipconfig' and press the Enter key on the keyboard. 
The current IP address of your PC will be displayed. 
 

 
 

If the network connection is unstable or the LAN cable is disconnected, the IP address of the 
PC will not be displayed. 

 
 

 

The SYNCON Screen

Main Screen 



 
 

 

 

 
1. The main menu allows you to navigate the basic functions of SYNCON sequentially. 

(In addition, you can right-click the opposite party or group to start a conversation and use the 
functions available in the displayed menu.) 
 

2. Displays the username for the Instant Message and Call functions.  
3. Shows the elapsed video call time. (This only appears when a video call is in progress.) 

 
4. You can view your phonebook and call history. 

 
5. Directly enter the IP address to call.  

 
6. Click the Send button to connect to the IP address entered in Step 5.  

Phonebook and Call History Screens

 

Phonebook Screen 
 

  
1. Displays the persons registered to your phonebook. 

 
2. Displays the groups in your phonebook. 
3. If you click on No. 2 (group), the users registered to the corresponding group will appear.  



 

 

Call History Screen 
 

  
1. Displays the outgoing, incoming, and missed calls. They are sorted in the order of the time 

that the call was made.  
 

2. Displays the time of calls made. (Outgoing calls) 
 

3. Displays the time of missed calls. (Missed calls)  
 

4. Displays the time of calls received. (Incoming calls)  

 
 

 

 

 

SYNCON Menus 

Main

  

 

  
Log Out 

 - Logs out from the SYNCON system. 

 The Log Out function may be restricted depending on whether the current mode is Server or 
Non-Server mode. 

 
Close

 - Minimizes SYNCON to an icon in the system tray.
  
  To exit SYNCON , use the menu displayed when right-clicking the icon in the system tray.

Actions

You can use basic functions, such as making a call, instant messaging, and muting the sound, etc.
  
 



 

 

 
  

 

Mute 
- Using this function, you can mute the audio data of a video call.  

(You can suspend a video call depending on your requirements.) 

 

Disconnect 
- Disconnects an existing call.

 

Call 
- Makes a call to the opposite party. 

 

Send Instant Message 
- Sends a message to the opposite party.

Office Sharing
- Allows you to share office files with persons you are chatting to.

Tools

 

You can add, edit or delete a person or group and check the IP address of a registered person. 
  
 

  

 

Add Person 
- Adds a person to whom you wish to make a video call.

 

Add Group 
- Adds a group of persons. 

 

Edit Group 
- Renames a group name.

 

Info 
- If Phonebook is selected, the information for the user selected in the phonebook is displayed. 

If Call history is selected, the information for the user selected in the call history is displayed. 

 

Edit 
- Edits the information for the user selected in the phonebook. 

(This is only enabled if the Phonebook is selected.)

 

Save
- Saves the information stored in the call history to the phonebook. 

(This is only enabled if the Call history is selected.)

 

View
- All :Displays all calls.
- Missed :Displays missed calls.
- Outgoing :Displays outgoing calls.
- Incoimng :Displays incoming calls.

 

Delete
- If the Phonebook is selected, the selected phonebook entry is deleted. 

If the Call history is selected, the selected call history entry is deleted.



 

 

Delete All 
- Deletes all Call history entries.

Settings

 

  
  You can configure the basic SYNCON environment using the Tools > Settings menu item. 
  
 

  
General 

1. General Settings  
2. When checked, SynCon starts automatically when Windows starts.  
3. When checked, your password is entered automatically in the Login screen.  
4. When checked, your SynCon is logged into the SynCon system automatically.  

The General Settings may be restricted depending on whether the current mode is Server 
or Non-Server mode. 

  
  



 

 
User Info 

1. User Information Settings  
2. This sets the name that appears when you are using the nstant Message or Call function.  
3. You can check the IP address of your PC.  

  
 

 
Video 

1. Video Settings  
2. Set the video size.  
3. Set the amount of video data transmitted per second.  
4. Set the amount of multimedia data transmitted per second.  
5. Set the video aspect ratio.  

If you have changed the Size to CIF/4CIF, you have to exit and then restart the SYNCON 
program. Otherwise the program may malfunction. 
Some functions of the Video Settings may be restricted depending on whether the current 
mode is Server or Non-Server mode. 

 
 

  
Sound 

1. Bell sound Settings.  
2. Set the bell type.  
3. Set the voice volume.  

  
 



  
Camera/MIC

1. Camera/MIC Settings  
2. Set the transmission type.  
3. Set the brightness and contrast for the camera.  
4. PIP Screen Location: Set the location of the PIP screen. 

(PIP Screen Off, Top Left, Top Right, Bottom Left, Bottom Right)  
Some functions of the Camera/MIC Settings may be restricted depending on whether the 
current mode is Server or Non-Server mode. 

  
 

  

 

About MCU
MCU is a device used for video conference calls. To use the Conference Call function,  
Settings > MCU (Multipoint Conferencing Unit) must be set to On. 
(For the MCU IP Address and MCU Service Prefix, ask your administrator for this 
information.)  

MCU
1. MCU Settings: You can hold a video conference with 2 to 6 users.  
2. When MCU is On, the MCU IP Address is activated. When it is Off , you cannot use the 

Conference Call function.  
3. MCU IP Address: You can enter the MCU IP address here.  
4. MCU Service Prefix: An MCU video conference type.  

(The default type is 80 and an administrator can change the value. To setup the value, 
contact your administrator.)  

Some MCU functions may be restricted depending on whether the current mode is Server or 
Non-Server mode. 

  
 



  
Call Control 

1. Call Control Settings  
2. When checked, call waiting is enabled.  
3. When the person being called cannot answer the phone, it enables the call to be forwarded 

to another user. If you click the checkbox, the Browse item will be activated.  
4. The phone number for the Call Forward function is automatically determined and it cannot 

be specified directly by a user.  
5. If you click Browse, a dialog box is opened.  

- Select a number and click OK. The selected number is displayed in input field 4.  
Even if the Set Call Waiting /Set Call Forward of Settings > Call control is selected, the 
function will not be available during a video conference.  
(The call waiting and forwarding functions will not be supported for all video conference 
participants including the host of the conference, during a video conference.) 

 
 

 

Making a Video Call

Dialog Box Overview 

Basic Menus 
 

 
1. Office Sharing Button

You can share Office files using this button.  
 

2. Adjustment Button 
You can adjust the screen brightness and contrast using this button.  



 
 

 

 

 
3. Fix Ratio Button

You can fix the aspect ratio of the video window when resizing it using this button. 
 

4. PIP (Picture In Picture) Button 
You can set up PIP (Picture In Picture) using this button.  
 

5. AV Mute Button
Using this button, you can mute the audio of a call.  

 
Once the AV Mute button is pressed, you can only use this button again after 3 seconds. 

6. Size
Shows the resolution to be transmitted for the user you are talking with. (CIF/4CIF) 
 

7. bps Configuration Tab 
Shows the data transmission rate for the user you are talking with.  

 
The bps configuration tab is only enabled 3 seconds after a user sets the bps.

8. Screen Name
Shows the screen name and IP address of the user you are talking with.  
 

9. Mute Button
You can mute the sound from the monitor.  

 
Once the Mute button is pressed, you can only use this button again after 3 seconds. 

10.Volume Control Bar
You can control the volume of the monitor.  
 

11.Current Time/Call Time 
The time on the left is the current time and the time on the right is the elapsed time of the current 
call. 
 

Sending/Receiving/Disconnecting a Call

 

1. In the Phonebook screen, select and right-click the person to video call and select Call from the 
displayed menu. 

Sending a Call 
 

 

  

 

  
Some Ways to Make a Video Call 

 1.In the Phonebook screen, double-click the person to video call. 
2.

In the Call history screen, double-click an entry of the person to video call, or right-click it 



 

 

 
 

 

and select Call from the displayed menu.
3.Select the person to video call and select Call from the Actions menu in the SYNCON 

main screen.
  

If the opposite party does not accept the call or is not connected to SYNCON, you cannot hold 
a video call.  

 

Receiving a Call
 

 
1. If the call rings while you are connected to SYNCON, click the Connect button. The video call 
will be connected.
 

If you do not want to receive a call, click the Reject button.

 

Disconnecting a Call 
 

Disconnecting a Call Using the Close Button 
 

 

  
If you want to disconnect a video call, click the Close button. The Disconnect window is 
displayed as shown in the figure below. Click OK. 

Conference Call with Two or More Persons

Making a Call 
 



 
 

 

 

1. Select 2 or more users to talk to in the SYNCON Phonebook screen by dragging the users with 
the mouse. Right-click over them and select Conference Call to make a conference call with 2 
or more users. 

  

 

  
2. You can make a conference call by selecting 2 or more users to talk to by dragging the users
with the mouse and selecting [Actions] > [Conference Call] from the pop-up menu that appears 
when right-clicking. 
A conference call supports up to 5 users besides yourself. 
The screen for a participant may be black during the conference call. When this occurs, ask 
your system administrator for assistance.

Sharing an Office File

Sharing an Office File with the Opposite Party
1. Click the Office Sharing button in the video call screen.  
 

 
2. The Open window is displayed as shown in the figure below. Select the file you want to share 
and click OK.   
 



 

 
3. The Office Sharing window as shown in the figure below is displayed until the opposite party 
accepts sharing the office file. If you click Cancel, sharing the office file is cancelled.  
 
 

  
 

File sharing can be activated by selecting Office Sharing from the Actions menu in the 
SYNCON  main screen when a video call is connected to the opposite party.

  
If you want to share a file by selecting Office Sharing from the Actions menu in the 
SYNCON main screen, they are enabled only if a video call is connected to the opposite 
party. 

 
Accepting Office File Sharing  

 
 1. If the opposite party requests the sharing of an office file, the Office Sharing window as shown 

in the figure below is displayed. Click OK.
 
 

  
 

Click Cancel if you do not want to share and view the office file.
 
 
 2. The 'Sending Files..' window is displayed as shown in the figure below. The Office Viewer is 

run automatically and displays the shared office file. 
 

 
 



  
 

Exiting Office Viewer  
 

 
 1. Click the Close button of the Office Viewer.
 
 

 
 2. The Disconnect window is displayed as shown in the figure below. Click OK.
 
 

  
 
The user who shared the file can exit Office Viewer.

 

 

Managing Persons and Groups 

Adding and Deleting a Person or Group Entry

Adding a Person Entry



 

 
1. Select Add Person from the Tools menu. 
 

 
2. In the Add Person window, enter the information for the person you wish to call and click OK. 
 

 
3. You can check that the person is added to the phonebook.  
 
 



  
  

You can add a person using the menu displayed when right-clicking on the Phonebook 
screen. 
 

 

Adding a Group Entry 
 

 
1. Select Add Group from the Tools menu. 
 

 
2. In the Add Group window, enter a group name and click OK. 
 



 
3. You can check that the group is added to the phonebook.  
 
  

 
 

  
You can add a group using the menu displayed when right-clicking on the Phonebook screen. 
 

Deleting a Person Entry 



 

 
1. Select and right-click the entry you wish to delete and select Delete from the displayed menu. 
 

 
2. Click OK.  
 
 
 

  
  

You can delete an entry by clicking on it and selecting Delete from the Tools menu.  
 

Deleting a Group 
 



 

 

 

 
1. Select and right-click the group entry you wish to delete and select Delete Group from the 
displayed menu. 
 

 
2. Click OK. 
 
 
 

  
  

You can delete a group entry by clicking on it and selecting Delete Group from the Tools 
menu.  
 

Editing/Viewing the Information for a Person 

Editing the Information for a Person  
 



 

 

 
1. Select and right-click the entry you wish to edit and select Edit from the displayed menu.
 

 
2. In the Edit Person window, change the information and click OK. 
  

 
 
 

You can edit an entry by clicking on it and selecting Edit from the Tools menu. 

Renaming a Group

 
1. Select and right-click the group entry you wish to edit and select Edit Group from the displayed 



 

menu. 
 

 
2. Change the group name and click OK. 
 

  
 
3 . The group's name is changed. 
 
 

  
  

You can rename a group entry by clicking on it and selecting Edit Group from the Tools menu. 
 
Viewing the Information for a Person 
 

 
1. Select and right-click an entry and select Info from the displayed menu. 
 



 
 

 

 
2. The Info window displays the information for the selected person.  
 

 

  
  

You can view the information for a person by clicking on that entry and selecting Info from the 
Tools menu.



 

 

 

Monitor Driver 

When prompted by the operating system for the monitor driver, insert the CD-ROM included with this 
monitor. Driver installation is slightly different from one operating system to another. Follow the 

directions appropriate for the operating system you have.  
 

Prepare a blank disk and download the driver program file at the Internet web site shown below.  
 

Internet web site :http://www.samsung.com/ (Worldwide)
http://www.samsung.com/monitor (U.S.A)
http://www.sec.co.kr/monitor (Korea)
http://www.samsungmonitor.com.cn/ (China)

Installing the Monitor Driver (Automatic)

 Insert the CD into the CD-ROM drive. 
Click "Windows".
Choose your monitor model in the model list, then click the "OK" button.  

 
 
If you can see following message window, then click the "Continue Anyway" button. Then click the 
"OK" button (Microsoft® Windows® XP/2000 Operating System).  

 
 



 
 

 

 
 

 
 

This monitor driver is under certifying MS logo, and this installation doesn't damage your 
system.  
The certified driver will be posted on Samsung Monitor homepage  
 
http://www.samsung.com/ 

Monitor driver installation is completed. 

Installing the Monitor Driver (Manual)

Windows Vista | Windows XP | Windows 2000 | Windows ME | Windows NT | Linux 

Microsoft® Windows Vista™ Operating System  
 

Insert your Manual CD into your CD-ROM drive.
Click (Start) and "Control Panel". Then, double-click on "Appearance and Personalization".  

 
 

   

Click "Personalization" and then "Display Settings".  

 
 

   

Click "Advanced Settings…".  

  
 
Click "Properties" in the "Monitor" tab. If the "Properties" button is deactivated, it means the 
configuration for your monitor is completed. The monitor can be used as is. 
If the message “Windows needs…” is displayed, as shown in the figure below,  
click "Continue". 



 

 

    

This monitor driver is under certifying MS logo, and this installation doesn't damage your 
system.  
The certified driver will be posted on Samsung Monitor homepage  
 
http://www.samsung.com/ 

Click "Update Driver…" in the "Driver" tab.  

 
 

   

Check the "Browse my computer for driver software" checkbox and click "Let me pick from a list 
of device drivers on my computer".  

 
 

   

Click "Have Disk…" and select the folder (for example, D:\Drive) where the driver setup file is 
located, and click "OK".  

 

   

Select the model that matches your monitor from the list of monitor models on the screen, and 
click "Next".  



 
 

  
 
Click "Close"→ "Close" → "OK" → "OK" on the following screens displayed in sequence. 

   

   

Microsoft® Windows® XP Operating System  

 
Insert the CD into the CD-ROM drive.
Click "Start" → "Control Panel" then click the "Appearance and Themes" icon.  

  
 

Click "Display" icon and choose the "Settings" tab then click "Advanced."  



  
 
Click the "Properties" button on the "Monitor" tab and select "Driver" tab.  

    
 
Click "Update Driver." and select "Install from a list or." then click the "Next" button.  

   
 
Select "Don't search ,I will." then click "Next" and then click "Have disk".  

  
 

Click the "Browse" button then choose A:(D:\Driver) and choose your monitor model in the model 
list and click the "Next" button.  



 
 

  
 
If you can see following "Message" window, then click the "Continue Anyway" button. Then click 
the "OK" button.  

 
 

 
 

This monitor driver is under certifying MS logo, and this installation doesn't damage your 
system.  
The certified driver will be posted on Samsung Monitor homepage  
 
http://www.samsung.com/ 

Click the "Close" button then click the "OK" button continually.  

  
 

Monitor driver installation is completed.  
 

Microsoft® Windows® 2000 Operating System  

 
 When you can see "Digital Signature Not Found" on your monitor, follow these steps.  

 
 

Choose the "OK" button on the "Insert disk" window. 
Click the "Browse" button on the "File Needed" window. 
Choose A:(D:\Driver) then click the "Open" button and then click the "OK" button. 



 
 

 
 

 

 
 

How to install 
Click "Start," "Setting," and then "Control Panel." 
Double click the "Display" icon. 
Select the "Settings" tab and click the "Advanced Properties" button. 
Choose "Monitor."  
Case1 : If the "Properties" button is inactive, it means your monitor is properly configured. Please 

stop installation 
Case2 : If the "Properties" button is active, click the "Properties" button then follow next steps 

continually.
Click "Driver" and then click "Update Driver." then click the "Next" button. 
Choose "Display a list of the known drivers for this device so that I can choose a specific driver" 
then click "Next" and then click "Have disk".
Click the "Browse" button then choose A:(D:\Driver). 
Click the "Open" button, then click the "OK" button. 
Choose your monitor model and click the "Next" button then click "Next" button. 
Click the "Finish" button then the "Close" button.  
 
If you can see the "Digital Signature Not Found" window then click the "Yes" button. And click the 
"Finish" button then the "Close" button. 

Microsoft® Windows® Millennium Operating System   

 
Click "Start," "Setting," and then "Control Panel." 
Double click the "Display" icon. 
Select the "Settings" tab and click the "Advanced Properties" button. 
Select the "Monitor" tab. 
Click the "Change" button in the "Monitor Type" area. 
Choose "Specify the location of the driver." 
Choose "Display a list of all the driver in a specific location." then click the "Next" button. 
Click the "Have Disk" button. 
Specify A:\(D:\driver) then click the "OK" button. 
Select "Show all devices" and choose the monitor that corresponds to the one you connected to 
your computer and click "OK". 
Continue choosing "Close" button and "OK" button until you close the Display Properties dialogue 
box. 

Microsoft® Windows® NT Operating System   

 
Click "Start," "Settings," "Control Panel," and then double-click "Display" icon.
In the Display Registration Information window, click the Settings tab and then click "All Display 
Modes".
Select a mode that you wish to use (Resolution, Number of colors and Vertical frequency) and 
then click "OK". 
Click the "Apply" button if you see the screen working normally after clicking "Test". If the screen 
is not normal, change to a different mode (lower mode of resolution, colors, or frequency). 

If there is no Mode at All Display Modes, select the level of resolution and vertical 
frequency by referring to the Preset Timing Modes in the user guide.

Linux Operating System   
 
To execute X-Window, you need to make the X86Config file, which is a type of system setting file.  
 

Press "Enter" at the first and the second screen after executing the X86Config file. 
The third screen is for setting your mouse. 
Set a mouse for your computer. 
The next screen is for selecting a keyboard. 
Set a Keyboard for your computer. 
The next screen is for setting your monitor. 
First of all, set a horizontal frequency for your monitor. (You can enter the frequency directly.) 
Set a vertical frequency for your monitor. (You can enter the frequency directly.) 
"Enter" the model name of your monitor. This information will not affect the actual execution of X-
Window. 
You have finished setting up your monitor.  
Execute X-Window after setting other requested hardware. 



 

 

 

 

 

 

Natural Color 

Natural Color

One of the recent problems in using a computer is that the color of the images printed out by a printer 
or other images scanned by a scanner or a digital camera are not the same as those shown on the 
monitor.  
the Natural Color S/W is the very solution for this problem. It is a color administration system 
developed by Samsung Electronics in association with Korea Electronics & Telecommunications 
Research Institute (ETRI).  
This is only available for Samsung monitors and ensures that the color of the images on the monitor 
are the same as the printed or scanned images.  
For more information, refer to Help (F1) in the software program.  

Installing the Natural Color Software 

Insert the CD included with the Samsung monitor into the CD-ROM Drive. The initial Natural Color 
screen will appear. Click on Natural Color in the startup window to install the Natural Color software.  
To install the program manually, insert the CD included with the Samsung monitor into the CD-ROM 
Drive, click the Windows [Start] button, select [Run...] .  
Enter D:\Color\NCProSetup.exe and then press the <Enter> key.  
(If the drive where the CD is inserted is not D:\, enter the applicable drive.) 

Uninstalling the Natural Color Software Program

Select "Settings" / "Control Panel" from the "Start" menu and then double-click "Add/Delete a 
program"  
Select Natural Color from the list and then click the "Add/Delete" button.  

MagicTune™

 

 Installation 
 

1. Insert the installation CD into the CD-ROM drive. 
2. Click the MagicTune™ installation file.  
3. Select installation Language, Click "Next". 
4. When the Installation Shield Wizard window appears, click "Next."  
5. Select "I agree to the terms of the license agreement" to accept the terms of use.  
6. Choose a folder to install the MagicTune™ program. 
7. Click "Install." 



8. The "Installation Status" window appears. 
9. Click "Finish." 

10. When the installation is complete, the MagicTune™ executable icon appears on your desktop.  
 
Double-click the icon to start the program.  
 

 

 

 

MagicTune™ execution icon may not appear depending on specification 
of computer system or monitor.  
If that happens, press F5 Key.

 

 

 
 

 Installation Problems (MagicTune™) 
 
The installation of MagicTune™ can be affected by such factors as the video card, motherboard and the 
network environment.  
 

 
 

 System Requirements
 
OS 

Windows 2000  
Windows XP Home Edition  
Windows XP Professional  
Windows Vista™  

Hardware 

32MB Memory above  
60MB Hard disk space above  

* For more information, visit the MagicTune™ website.  

 

 
It is recommended using MagicTune™ in Windows® 2000  
or later. 

 

  

 
 

 Uninstall 
 
 

The MagicTune™ program can be removed only by using the "Add or Remove Programs" option of the 
Windows® Control Panel.  

Perform the following steps remove MagicTune™. 

1. Go to [Task Tray] ' [Start] ' [Settings] and select [Control Panel] in the menu. If the program runs on 
Windows® XP, go to [Control Panel] in the [Start] menu.  
 

2. Click the "Add or Remove Programs" icon in Control Panel.  
 

3. In the "Add or Remove Programs" screen, scroll down to find "MagicTune™". Click on it to highlight it. 
 
 

4. Click the "Change/Remove" button to remove the program.  
 

5. Click "Yes" to begin the uninstall process.  
 

6. Wait until the "Uninstall Complete" dialog box appears.  



Visit the MagicTune™ website for technical support for MagicTune™, FAQs (questions and answers) and 
software upgrades. 



 

 
 

Control Buttons 

 

[ ] Opens the OSD menu. Also use to exit the OSD menu or return to the previous menu.

[ ] These buttons allow you to adjust items in the menu.

[ ] Press this button to activate a highlighted menu item. 

[AUTO] When the 'AUTO' button is pressed, the Auto Adjustment screen appears as shown in the 
animated screen on the center.

 

 

Direct Functions 

AUTO



 

 
 

 

Menu Description

AUTO 

When the 'AUTO' button is pressed, the Auto Adjustment screen appears as 
shown in the animated screen on the center.  
Auto adjustment allows the monitor to self-adjust to the incoming Analog signal. 
The values of fine, coarse and position are adjusted automatically.  
(Available in Analog mode only)  
 
 
To make the automatic adjustment function sharper, execute the 'AUTO' function 
while the AUTO PATTERN is on.  
 

If auto adjustment does not work properly, press 'AUTO' button again to adjust 
picture with more accuracy.

If you change resolution in the control panel, auto function will be executed 
automatically. 

OSD Locked & Unlock

 When pressing the AUTO button after locking the OSD



 

 
 

 

 When pressing the MENU button after locking the OSD

Menu Description

OSD Locked & 
Unlock

This is the function that locks the OSD in order to keep the current states of 
settings or prevent others from adjusting the current settings.  
 
Locked : Hold down the menu button for more than five seconds to activate the 
OSD adjustment lock function. 
 
Unlock : Hold down the menu button for more than five seconds to deactivate 
the OSD adjustment lock function. 
 

Though the OSD adjustment lock function is activated, you can still adjust 
the brightness and contrast, and adjust MagicBright ( ) using the Direct 
button.

MagicBright™



 

 
 

 

 

 
 

 

Menu Description

 MagicBright™

Push the MagicBright™ button to circle through available preconfigured 
modes.  
 
- Six different modes (Custom/Text/Internet/Game/Sport/Movie/) 

Volume

 

Menu Description

 Volume When OSD is not on the screen, push the button to adjust volume. 

SOURCE



 

 

 
 

 

Menu Description

SOURCE Selects the Video signal while the OSD is off. (Analog/Client) 

 

 
OSD Function 

Picture  Brightness  Contrast

Color  MagicColor  Color Tone  Color Control  Gamma

Image  Coarse  Fine  Sharpness  H-Position  V-Position

OSD  Language  H-Position  V-Position  Transparency  Display Time

Setup  SynCon  Image Reset  Color Reset

Information

 

 
Picture 



 

 
 

 

 

Menu Description Play/Stop

Brightness
You can use the on-screen menus to change the 
brightness according to personal preference.  
 
MENU →  →  →  ,  → MENU

Contrast
You can use the on-screen menus to change the contrast 
according to personal preference.  
 
MENU →  →  ,  →  →  ,  → MENU

Color 

Menu Description Play/Stop



 
 

 

 

MagicColor

 
MENU →  ,  → →  →  ,  → MENU

MagicColor is a new technology that Samsung has exclusively 
developed to improve digital image and to display natural color 
more clearly without disturbing image quality.  
 
 

Off Returns to the original mode.
Demo The screen before applying MagicColor appears 

on the right and the screen after applying 
MagicColor appears on the left. 

Full Displays not only vivid natural color but also 
more realistic natural skin color with clearness. 

Intelligent Displays vivid natural color with clearness. 

Color Tone
The tone of the color can be changed and one of four modes 
can be selected -Cool, Normal, Warm and Custom.  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

Color Control
Adjusts individual Red, Green, Blue color balance. -Red, Green, 
Blue  
 
MENU →  ,  →  →  ,  →  →  ,  →  →  ,  → MENU

Gamma

Gamma correction changes the luminance of the colors with 
intermediate luminance.  
 
- Mode 1  
- Mode 2  
- Mode 3  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

Image 

Menu Description Play/Stop

Coarse

Removes noise such as vertical stripes.  
Coarse adjustment may move the screen image area. You 
may relocate it to the center using the horizontal control 
menu. 
(Available in analog mode only)  



 
 

 

 

 
MENU →  ,  →  →  →  ,  → MENU

Fine

Removes noise such as horizontal stripes.  
If the noise persists even after fine tuning, repeat it after 
adjusting the frequency (clock speed). 
(Available in analog mode only)  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

Sharpness
Changes the clearance of image.  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

H-Position

Changes the horizontal position of the monitor's entire 
display. 
(Available in analog mode only)  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

V-Position

Changes the vertical position of the monitor's entire 
display. 
(Available in analog mode only)  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

OSD 

Menu Description Play/Stop

Language

You can choose one of nine languages.  

  

 
 
MENU →  ,  →  →  →  ,  → MENU 

The language chosen affects only the language of the OSD. It 
has no effect on any software running on the computer.

H-Position
You can change the horizontal position where the OSD menu 
appears on your monitor.  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU



 
 

 

 

 
 

 

V-Position
You can change the vertical position where the OSD menu 
appears on your monitor.  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

Transparency
Change the transparency of the background of the OSD.  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

Display Time

The menu will be automatically turned off if no adjustments are 
made for a certain time period.  
You can set the amount of time the menu will wait before it is 
turned off.  
- 5 sec, 10 sec, 20 sec, 200 sec  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

Setup 

Menu Description Play/Stop

SynCon 

You can enable (On) or disable (Off) the SOURCE button 
(Analog/Client).  
When disabled (Off), your monitor can be used as a 
general monitor only. 
In this case, even though the SOURCE button is pressed, 
it does not change to Client mode. 
 
MENU →  ,  →  →  →  ,  → MENU 

Image Reset 
Image parameters are replaced with the factory default 
values.  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

Color Reset
Color parameters are replaced with the factory default 
values.  
 
MENU →  ,  →  →  ,  →  →  ,  → MENU

Information 



 

 
 

Menu Description

Information
Shows a video source, display mode on the OSD screen.  
 
MENU →  ,  



 

 

Check List

Before calling for service, check the information in this section to see if you can remedy any problems 
yourself. If you do need assistance, please call the phone number on the Information section or contact 

your dealer. 

Symptom Check List Solutions

No images on the 
screen.  
I cannot turn on the 
monitor.

Is the power cord 
connected 
properly?

Check the power cord connection and supply.

Can you see 
"Check Signal 
Cable" on the 
screen? 

Check the signal cable connection. 

If the power is on, 
reboot the 
computer to see 
the initial screen
(the login screen), 
which can be seen. 

If the initial screen (the login screen) appears, boot the 
computer in the applicable mode (the safe mode for 
Windows ME/XP/2000) and then change the frequency 
of the video card.  
(Refer to the Preset Timing Modes)  
 
If the initial screen (the login screen) does not appear, 
contact the Service Center or your dealer.  

Can you see "Not 
Optimum Mode", 
"Recommended 
Mode 1680 x 1050 
60 Hz" on the 
screen? 

You can see this message when the signal from the 
video card exceeds the maximum resolution and 
frequency that the monitor can handle properly.  
 
Adjust the maximum resolution and frequency that the 
monitor can handle properly.  
 
If the display exceeds SXGA or 75 Hz, a "Not Optimum 
Mode", "Recommended Mode 1680 x 1050 60 Hz" 
message is displayed. If the display exceeds 85 Hz, the 
display will work properly but the "Not Optimum Mode", 
"Recommended Mode 1680 x 1050 60 Hz" message 
appears for one minute and then disappears.  
Please change to the recommended mode during this 
one-minute period.  
(The message is displayed again if the system is 
rebooted.) 

There is no image 
on the screen.  
Is the power 
indicator on the 
monitor blinking at 
1 second intervals?

The monitor is in PowerSaver mode.  
 
Press a key on the keyboard to activate the monitor and 
restore the image on the screen.  
 
If there is still no image, press the ' ' button.  
Then press any key on the keyboard again to activate 



the monitor and restore the image on the screen. 

I cannot see the On 
Screen Display.

Have you locked 
the On Screen 
Display (OSD) 
Menu to prevent 
changes?

Unlock the OSD by pressing the [ ] button for at 
least 5 seconds.

The screen shows 
strange colors or just 
black and white.

Is the screen 
displaying only one 
color as if looking 
at the screen 
through a 
cellophane paper? 

Check the signal cable connection.  
 
Make sure the video card is fully inserted in its slot.

Have the screen 
colors become 
strange after 
running a program 
or due to a crash 
between 
applications?

Reboot the computer.

Has the video card 
been set properly?

Set the video card by referring to the video card 
manual. 

The screen suddenly 
has become 
unbalanced.

Have you changed 
the video card or 
the driver?

Adjust screen image position and size using the OSD.

Have you adjusted 
the resolution or 
frequency to the 
monitor?

Adjust the resolution and frequency at the video card.  
(Refer to thePreset Timing Modes). 

The screen can be unbalanced due to the cycle of the video card signals. 
Readjust Position by referring to the OSD.

The screen is out of 
focus or OSD cannot 
be adjusted.

Have you adjusted 
the resolution or 
frequency on the 
monitor?

Adjust the resolution and frequency of the video card.  
(Refer to the Preset Timing Modes).

LED is blinking but 
no images on the 
screen.

Is the frequency 
properly adjusted 
when checking the 
Display Timing on 
the menu?

Adjust the frequency properly by referring to the video 
card manual and the Preset Timing Modes.  
(The maximum frequency per resolution may differ from 
product to product.) 

There are only 16 
colors shown on the 
screen. The screen 
colors have changed 
after changing the 
video card.

Have the Windows 
colors been set 
properly? 

Windows XP :  
Set the resolution at the Control Panel → Appearance 
and Themes → Display → Settings.  
 
Windows ME/2000 :  
Set the resolution at the Control Panel → Display → 
Settings. 

Has the video card 
been set properly?

Set the video card by referring to the video card 
manual. 

There is a message 
that reads 
"Unrecognized 
monitor, Plug & Play 
(VESA DDC) 
monitor found". 

Have you installed 
the monitor driver?

Install the monitor driver according to the Driver 
Installation Instructions.

See the video card 
manual to see if the 
Plug & Play (VESA 
DDC) function can 
be supported. 

Install the monitor driver according to the Driver 
Installation Instructions.

Check when 
MagicTune™ does 
not function properly.

MagicTune™ 
feature is found 
only on PC (VGA) 

* To check whether your PC is available for 
MagicTune™ feature, follow the steps below (When 
Windows is XP);  



Visit the MagicTune™ website and download the installation software for MagicTune™ MAC.

Check the following items if there is trouble with the monitor.

Symptom Solutions

The screen does 
not appear when I 
switch to the Client 
Mode.

To use the network function, approximately 30 seconds of booting time is 
required after turning the power on, and a blank screen appears for 3 to 4 
seconds during booting.  
Please switch the mode about 30 seconds after the power is turned on. 

The client screen 
appears, but I 
cannot connect to 
the server.

1) Check if the Hub port LED to which the LAN cable is connected blinks. If not, 
that indicates that the LAN connection is disconnected. In this case, connect 
using another LAN cable. 
 
2) Check if the settings of the 'Settings', 'Network' tab are properly set up. The 
default setting is "DHCP". If your network uses a static IP address, select 'Use 
the following IP address' and then enter the appropriate IP address information. 
 
3) Check if the 'User Name' and 'Password' set in the 'Remote Desktop' tab of 
'Settings' are the same as those of the host PC. If not, match the 'User Name' 
and 'Password' of the 'Remote Desktop' with those of the host PC.

I cannot access the 1) Check if the Hub port LED to which the LAN cable is connected blinks. If not, 

 

 
 

 

with Window OS 
that supports Plug 
and Play.

 
Control Panel → Performance and Maintenance → 
System → Hardware → Device Manager → Monitors → 
After deleting Plug and Play monitor, find 'Plug and Play 
monitor' by searching new Hardware. 

MagicTune™ is an additional software for the monitor. 
Some graphic cards may not support your monitor. 
When you have a problem with the graphic card, visit 
our website to check the compatible graphic card list 
provided.  
http://www.samsung.com/monitor/magictune

MagicTune™ 
doesn't work 
properly.

Have you changed 
your PC or video 
graphic card? 
 
Did you install the 
program?

Download the latest program. The program can be 
downloaded 
http://www.samsung.com/monitor/magictune  
 
 
Reboot the computer after installing the program for the 
first time. If a copy of the program is already installed, 
remove it, reboot the computer, and then install the 
program again. You need to reboot the computer for it 
to operate normally after installing or removing the 
program.

Problems related to 
Audio 

No sound Ensure that the audio cable is firmly connected to both 
the audio-in port on your monitor and the audio-out port 
on your sound card.  
(Refer to Connecting the Monitor)  
 
Check the volume level. 

Sound level is too 
low. 

Check the volume level.  
 
If the volume is still too low after turning the control to its 
maximum, check the volume control on the computer 
sound card or software program.

I pressed the Power 
button to turn the 
monitor off. But only 
the message 'Please 
Wait' appears and 
the monitor does not 
turn off even after a 
lot of time has 
passed.

Please shut down 
the monitor 
forcefully.

Windows XPe may sometimes not shut down normally. 
In this case, please shut the monitor down by force by 
holding down the Power Button for five (5) seconds.



 

 

Internet in the 
Client screen.

that indicates that the LAN connection is disconnected. In this case, connect 
using another LAN cable. 

2) Check if the settings of the 'Network' tab of 'Settings' have been properly set 
up. The default setting is "DHCP". If your network uses a static IP address, 
select 'Use the following IP address' and then enter the appropriate IP address 
information. 

The contents 
(video, voice) on 
the server do not 
play smoothly on 
the Client Monitor.

This is because the data is transmitted over the LAN. Check your LAN 
connection status.

I have connected a 
digital device such 
as a digital camera, 
camcorder or USB 
memory to the USB 
port, but they do 
not work.

This model supports USB devices that support removable disk functions without 
an additional driver installation. Check if the device you want to connect to is a 
device that supports the removable disk function without an additional driver 
installation. 

The file list does 
not appear.

1) Check the files on the card. If only abnormal files (e.g. 0KByte, broken JPEG) 
exist, the files do not appear on the screen. 
 
2) The time required to display is determined by the size of the file. Wait a 
moment. 
 
3) Check if the format of the file is supported by the Client Monitor. If the 
extension of the file has been changed, the file will not be played.

Check if the power cord and the video cables are properly connected to the computer.

Check if the computer beeps more than 3 times when booting.  
(If it does, request an after-service for the main board of the computer.) 

If you installed a new video card or assembled the PC, please check if the adapter(video) driver and 
the monitor driver are properly installed. 

Check if the scanning ratio of the video screen is set at 56 Hz ~ 75 Hz.  
(Do not exceed 60 Hz when using the maximum resolution.)

If you have problems in installing the adapter (video) driver, boot the computer in Safe Mode, remove 
the Display Adapter at the "Control Panel → System → Device Administrator" and then reboot the 
computer to reinstall the adapter (video) driver. 

If problems repeatedly occur, contact an authorized service center.

 
Q & A

Question Answer 

How can I change the frequency? Frequency can be changed by reconfiguring the 
video card.  
 
Note that video card support can vary, depending on 
the version of the driver used.  
(Refer to the computer or the video card manual for 
details.) 

How can I adjust the resolution? Windows XP :  
Set the resolution at the Control Panel → 
Appearance and Themes → Display → Settings.  
 
Windows ME/2000 :  
Set the resolution at the Control Panel → Display → 
Settings.  
 

Contact the video card manufacturer for details.



How can I set the Power Saving function? Windows XP :  
Set the resolution at the Control Panel → 
Appearance and Themes → Display → Screen 
Saver.  
Set the function at BIOS-SETUP of the computer.  
 
Windows ME/2000 :  
Set the resolution at the Control Panel → Display → 
Screen Saver.  
Set the function at BIOS-SETUP of the computer.  
 

Refer to Windows/Computer Manual

How can I clean the outer case/LCD Panel? Disconnect the power cord and then clean the 
monitor with a soft cloth, using either a cleaning 
solution or plain water.  
 
Do not leave any remains of the detergent nor 
scratch the case. Do not allow any water to go inside 
the monitor. 

 

 
 

 
 

 

 

 

Self-Test

Self-Test Feature Check  |  Warning Messages  |  Environment  |  Useful Tips

Your monitor provides a self test feature that allows you to check whether your monitor is functioning 
properly. 

Self-Test Feature Check 

Turn off both your computer and the monitor.

Unplug the video cable from the back of the computer. 

Turn on the monitor. 

If the monitor is functioning properly, you will see a box in the illustration below.  
 

  
 
This box appears during normal operation if the video cable becomes disconnected or damaged.  
 

Turn off your monitor and reconnect the video cable; then turn on both your computer and the 
monitor. 

If your monitor screen remains blank after using the previous procedure, check your video controller 
and computer system; your monitor is functioning properly.

Warning Messages 

If there is something wrong with the input signal, a message appears on the screen or the screen 
goes blank although the power indicator LED is still on. The message may indicate that the monitor is 
out of scan range or that you need to check the signal cable.  
 



 

 

 

 

 

 

Environment 

The location and the position of the monitor may influence the quality and other features of the 
monitor.  
 

If there are any sub woofer speakers near the monitor, unplug and relocate the woofer to another 
room.  
Remove all electronic devices such as radios, fans, clocks and telephones that are within 3 feet 
(one meter) of the monitor. 

Useful Tips 

A monitor recreates visual signals received from the computer. Therefore, if there is trouble with the 
computer or the video card, this can cause the monitor to become blank, have poor coloring, noise, 
Video mode not supported, etc. In this case, first check the source of the problem, and then contact 
the Service Center or your dealer.  
 

Judging the monitor's working condition  
 
If there is no image on the screen or a "Not Optimum Mode", "Recommended Mode 1680 x 1050 60 
Hz" message comes up, disconnect the cable from the computer while the monitor is still powered on.  
 

If there is a message coming up on the screen or if the screen goes white, this means the monitor 
is in working condition. 
In this case, check the computer for trouble. 



 
Specifications

General

Model Name SyncMaster 220TN

LCD Panel

Size 22 inch (55 cm)

Display area 473.76 (H) x 296.1 (V) 

Pixel Pitch 0.282 (H) x 0.282 (V) 

Synchronization

Horizontal 30 kHz ~ 81 kHz

Vertical 56 Hz ~ 75 Hz

Display Color

16.7 M

Resolution

Optimum resolution 1680 x 1050 @ 60 Hz

Maximum resolution 1680 x 1050 @ 60 Hz

Input Signal, Terminated

RGB Analog  
0.7 Vp-p ± 5 % 
separate H/V sync, Composite H/V sync 
TTL level (V high ≥ 2.0 V, V low ≤ 0.8 V) 

Maximum Pixel Clock

146 MHz 

Power Supply

AC 100-240 ~ VAC ( ± 10 %),60 / 50 Hz ± 3 Hz



 

 
 

 

Signal Cable

15pin-to-15pin D-sub cable, Detachable

Dimensions (W x H x D) / Weight 

520.0 X 399.0 X 68.5 mm / 20.5 X 15.7 X 2.7 inch (Without Stand) 
520.0 X 452.0 X 202.0 mm / 20.5 X 17.8 X 8.0 inch / 7.9 kg / 17.4 Ibs(With stand)

VESA Mounting Interface

100 x 100 mm (For use with Specialty(Arm) Mounting hardware.)

Environmental considerations

Operating Temperature: 10 ℃ ~ 40 ℃ (50 °F~104 °F)  
Humidity: 20 % ~ 80 %, non-condensing

Storage Temperature: -20 ℃ ~ 60 ℃ (-4 °F ~ 140 °F)  
Humidity: 10 % ~ 80 %, non-condensing

Plug and Play Capability

This monitor can be installed on any Plug & Play compatible system. Interaction of the monitor and 
computer systems will provide the best operating conditions and monitor settings. In most cases, 
monitor installation will proceed automatically, unless the user wishes to select alternate settings.

Dot Acceptable

TFT LCD panel manufactured by using advanced semiconductor technology with precision of 1 ppm 
(one millionth) above is used for this product. But the pixels of RED, GREEN, BLUE and WHITE color 
seem to be bright sometimes or some of black pixels could be seen. This is not from bad quality and 
you can use it without uneasiness.  
 
For example, the number of TFT LCD sub pixels that is contained in this product are 5,292,000. 

Design and specifications are subject to change without prior notice.

Class B Equipment (Information Communication equipment for residential use)

This product complies with the Electromagnetic Compatibility Directives for residential use and can be 
used in all areas including common residential areas. 
 
(Class B equipment emits less electromagnetic waves than Class A equipment.)

 

 

 

PowerSaver 

PowerSaver (When used as a normal monitor)

This monitor has a built-in power management system called PowerSaver. This system saves energy 
by switching your monitor into a low-power mode when it has not been used for a certain amount of 
time. The monitor automatically returns to normal operation when you press a key on the keyboard. 
For energy conservation, turn your monitor OFF when it is not needed, or when leaving it unattended 
for long periods. The PowerSaver system operates with a VESA DPM compliant video card installed 
in your computer. Use a software utility installed on your computer to set up this feature.

State Normal Operation Power saving mode Power off  
(Power button) 

Power Indicator Blue Blue Blinking OFF

Power Consumption Less than 60watts Less than Less than 



 
 

 

 

4 watts  4 watts 

PowerSaver (When used as a Network monitor)

This monitor has a built-in power management system called PowerSaver. This system saves energy 
by switching your monitor into a low-power mode when it has not been used for a certain amount of 
time. The monitor automatically returns to normal operation when you press a key on the keyboard. 
For energy conservation, turn your monitor OFF when it is not needed, or when leaving it unattended 
for long periods. The PowerSaver system operates with a VESA DPM compliant video card installed 
in your computer. Use a software utility installed on your computer to set up this feature.

State Normal Operation Power saving mode Power off  
(Power button) 

Power Indicator Blue Blue Blinking OFF

Power Consumption Less than 60watts Less than 27 W Less than 
4 watts 

 

 

 

Preset Timing Modes

If the signal transferred from the computer is the same as the following Preset Timing Modes, the 
screen will be adjusted automatically. However, if the signal differs, the screen may go blank while 
the power LED is on. Refer to the video card manual and adjust the screen as follows. 

Preset Timing Modes 

Display Mode
Horizontal 
Frequency  

(kHz)

Vertical 
Frequency  

(Hz)

Pixel Clock  
(MHz)

Sync Polarity  
(H/V)

IBM. 640 x 350 31.469 70.086 25.175 +/-

IBM. 640 x 480 31.469 59.940 25.175 -/-

IBM. 720 x 400 31.469 70.087 28.322 -/+

MAC. 640 x 480 35.000 66.667 30.240 -/-

MAC. 832 x 624 49.726 74.551 57.284 -/-

MAC. 1152 x 870 68.681 75.062 100.000 -/-

VESA. 640 x 480 37.861 72.809 31.500 -/-

VESA. 640 x 480 37.500 75.000 31.500 -/-

VESA. 800 x 600 35.156 56.250 36.000 +/+

VESA. 800 x 600 37.879 60.317 40.000 +/+

VESA. 800 x 600 48.077 72.188 50.000 +/+

VESA. 800 x 600 46.875 75.000 49.500 +/+

VESA. 1024 x 768 48.363 60.004 65.000 -/-

VESA. 1024 x 768 56.476 70.069 75.000 -/-



 
 

VESA. 1024 x 768 60.023 75.029 78.750 +/+

VESA, 1280 x 768 60.289 74.893 102.250 -/+

VESA. 1280 x 960 60.000 60.000 108.000 +/+

VESA. 1280 x 
1024 63.981 60.020 108.000 +/+

VESA. 1280 x 
1024 79.976 75.025 135.000 +/+

VESA.1680 x 1050 64.674 59.883 119.000 +/-

Horizontal Frequency

The time to scan one line connecting the right edge to the left edge of the 
screen horizontally is called Horizontal Cycle and the inverse number of 
the Horizontal Cycle is called Horizontal Frequency. Unit : kHz 

Vertical Frequency

Like a fluorescent lamp, the screen has to repeat the same image many 
times per second to display an image to the user. The frequency of this 
repetition is called Vertical Frequency or Refresh Rate. Unit : Hz



 

 
 

Contact SAMSUNG WORLDWIDE

If you have any questions or comments relating to Samsung products, please contact the 
SAMSUNG customer care center. 

North America

U.S.A 1-800-SAMSUNG (726-7864) http://www.samsung.com/us 

CANADA 1-800-SAMSUNG (726-7864) http://www.samsung.com/ca 

MEXICO 01-800-SAMSUNG (726-7864) http://www.samsung.com/mx 

Latin America

ARGENTINE 0800-333-3733 http://www.samsung.com/ar 

BRAZIL 0800-124-421 
4004-0000 http://www.samsung.com/br 

CHILE 800-SAMSUNG(726-7864) http://www.samsung.com/cl 

COLOMBIA 01-8000112112 http://www.samsung.com.co

COSTA RICA 0-800-507-7267 http://www.samsung.com/latin 

ECUADOR 1-800-10-7267 http://www.samsung.com/latin 

EL SALVADOR 800-6225 http://www.samsung.com/latin 

GUATEMALA 1-800-299-0013 http://www.samsung.com/latin 

JAMAICA 1-800-234-7267 http://www.samsung.com/latin 

PANAMA 800-7267 http://www.samsung.com/latin 

PUERTO RICO 1-800-682-3180 http://www.samsung.com/latin 

REP. DOMINICA 1-800-751-2676 http://www.samsung.com/latin 

TRINIDAD & 
TOBAGO 1-800-SAMSUNG(726-7864) http://www.samsung.com/latin 

VENEZUELA 0-800-100-5303 http://www.samsung.com/latin 

Europe



AUSTRIA 0800-SAMSUNG(726-7864) www.samsung.com/at

BELGIUM 0032 (0)2 201 24 18                                  http://www.samsung.com/be 

CZECH REPUBLIC 844 000 844 http://www.samsung.com/cz 

 

DENMARK 70 70 19 70 http://www.samsung.com/dk 

FINLAND 030-6227 515 http://www.samsung.com/fi 

FRANCE 3260 SAMSUNG(726-7864) 
08 25 08 65 65 (€ 0,15/Min) http://www.samsung.com/fr 

GERMANY 01805-SAMSUNG(726-7864)  
(€ 0,14/Min) http://www.samsung.de 

HUNGARY 06-80-SAMSUNG(726-7864) http://www.samsung.com/hu 

ITALIA 800-SAMSUNG(726-7864) http://www.samsung.com/it 

LUXEMBURG 0035 (0)2 261 03 710 http://www.samsung.com/be 

NETHERLANDS 0900 SAMSUNG(726-7864)  
(€ 0,10/Min) http://www.samsung.com/nl 

NORWAY 815-56 480 http://www.samsung.com/no 

POLAND 0 801 801 881  
022-607-93-33 http://www.samsung.com/pl 

PORTUGAL 80 8 200 128 http://www.samsung.com/pt 

REPUBLIC OF 
IRELAND 0818 717 100 http://www.samsung.com/ie 

SLOVAKIA 0800-SAMSUNG(726-7864) http://www.samsung.com/sk 

SPAIN 902 10 11 30 http://www.samsung.com/es 

SWEDEN 0771-400 200 http://www.samsung.com/se 

SWITZERLAND 0800-SAMSUNG(726-7864) http://www.samsung.com/ch

U.K 0870-SAMSUNG(726-7864) http://www.samsung.com/uk 

CIS

ESTONIA 800-7267 http://www.samsung.ee

LATVIA 800-7267 http://www.samsung.com/lv

LITHUANIA 8-800-77777 http://www.samsung.lt

KAZAHSTAN 8-10-800-500-55-500 http://www.samsung.kz 

KYRGYZSTAN 00-800-500-55-500  

RUSSIA 8-800-555-55-55 http://www.samsung.ru 

UKRAINE 8-800-502-0000 http://www.samsung.ua 

UZBEKISTAN 8-800-120-0-400 http://www.samsung.uz

Asia Pacific



CHINA 800-810-5858, 010- 6475 1880 http://www.samsung.com.cn 

HONG KONG 3698-4698 http://www.samsung.com/hk 

INDIA 3030 8282  
1800 110011 http://www.samsung.com/in 

INDONESIA 0800-112-8888 http://www.samsung.com/id 

JAPAN 0120-327-527 http://www.samsung.com/jp 

MALAYSIA 1800-88-9999 http://www.samsung.com/my 

NEW ZEALAND 0800SAMSUNG(726-7864) http://www.samsung.com/nz

PHILIPPINES 1800-10-SAMSUNG(726-7864) http://www.samsung.com/ph 

SINGAPORE 1800-SAMSUNG(726-7864) http://www.samsung.com/sg 

THAILAND 1800-29-3232, 02-689-3232 http://www.samsung.com/th 

TAIWAN 0800-329-999 http://www.samsung.com/tw 

VIETNAM 1 800 588 889 http://www.samsung.com/vn 

Middle East & Africa

SOUTH AFRICA 0860-SAMSUNG(726-7864 ) http://www.samsung.com/za 

TURKEY 444 77 11 http://www.samsung.com.tr

U.A.E 800-SAMSUNG (726-7864)  
8000-4726 http://www.samsung.com/mea 

 

 

 
 

 

 
 

 

 
 

 

 
 

Terms

Dot Pitch

The image on a monitor is composed of red, green and blue dots. The closer the dots, the higher the 
resolution. The distance between two dots of the same color is called the 'Dot Pitch'. Unit : mm

Vertical Frequency

The screen must be redrawn several times per second in order to create and display an image for the 
user. The frequency of this repetition per second is called Vertical Frequency or Refresh Rate. Unit : 
Hz  
 
Example : If the same light repeats itself 60 times per second, this is regarded as 60 Hz. 

Horizontal Frequency

The time to scan one line connecting the right edge to the left edge of the screen horizontally is called 
Horizontal Cycle. The inverse number of the Horizontal Cycle is called Horizontal Frequency. Unit : 
kHz

Interlace and Non-Interlace Methods

Showing the horizontal lines of the screen from the top to the bottom in order is called the Non-
Interlace method while showing odd lines and then even lines in turn is called the Interlace method. 
The Non-Interlace method is used for the majority of monitors to ensure a clear image. The Interlace 
method is the same as that used in TVs.



 

 
 

 

 

Plug & Play

This is a function that provides the best quality screen for the user by allowing the computer and the 
monitor to exchange information automatically. This monitor follows the international standard VESA 
DDC for the Plug & Play function.

Resolution

The number of horizontal and vertical dots used to compose the screen image is called 'resolution'. 
This number shows the accuracy of the display. High resolution is good for performing multiple tasks 
as more image information can be shown on the screen.  
 
Example :  If the resolution is 1680 x 1050 , this means the screen is composed of 1680 horizontal 

dots (horizontal resolution) and 1050 vertical lines (vertical resolution).

 
For Better Display

Adjust computer resolution and screen injection rate (refresh rate) oncomputer as described below to 
enjoy the best quality of picture. You can have an uneven quality of picture in the screen if the best 
quality of picture is not provided in TFT-LCD.  
 

Resolution : 1680 x 1050 
Vertical frequency (refresh rate) : 60 Hz

TFT LCD panel manufactured by using advanced semiconductor technology with precision of 1ppm 
(one millionth) above is used for this product. But the pixels of RED, GREEN, BLUE and WHITE color 
seem to be bright sometimes or some of black pixels could be seen.  
This is not from bad quality and you can use it without uneasiness.  
 

For example, the number of TFT LCD sub pixels that is contained in this product are 5,292,000. . 

When you clean the monitor and the panel outside, please apply the recommended small amount of 
cleaner by using soft and dry cloth and polish it. Let LCD area not to be forced but to be scrubbed out 
softly.  
If excessive force is applied, you can have a stain on it.

If you are not satisfied with the quality of the picture, you can get better quality of the picture by 
executing "auto adjustment function" in display screen that is appeared as window termination button 
is pressed.  
If there's still noise after automatic adjustment, use FINE/COARSE adjustment function. 

If you view a fixed screen for an extended period of time, residual image or blurriness may appear.  
Change the mode to energy save or set a screensaver to move the picture when you need to be 
away from the monitor for an extended period of time.

 

 

 
 

Authority

Information in this document is subject to change without notice.  
© 2007 Samsung Electronics Co., Ltd. All rights reserved.

Reproduction in any manner whatsoever without the written permission of Samsung Electronics Co., 
Ltd. is strictly forbidden.  
 
Samsung Electronics Co., Ltd. shall not be liable for errors contained herein or for incidental or 
consequential damages in connection with the furnishing, performance, or use of this material.  
 
Samsung is the registered trademark of Samsung Electronics Co., Ltd.; Microsoft, Windows and 
Windows NT are registered trademarks of Microsoft Corporation; VESA, DPM and DDC are 
registered trademarks of Video Electronics Standard Association; the ENERGY STAR® name and 
logo are registered trademarks of the U.S. Environmental Protection Agency (EPA). All other product 
names mentioned herein may be the trademarks or registered trademarks of their respective owners.
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